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Buildinga SharePoint 2010 Virtual Machine

Overview : This document provides links to Internet resources and step by step instructions for

building a Virtual Machine (VM) sample SharePoint Server 2010  environment . This VM can be used to
complete the lab exercise s in SharePoint 2010 training courses authored by Critical Path  Training , LLC.
The VM can also be used for general testing and development with SharePoint 2010

This setup guide gives you the option of using free trial software or supplying your own product keys.

The software products that require product keys include Windows Server 2008 R2, SQL Server 2008

R2 Enterprise, SharePoint Server 2010 and Office 2010. If you plan to use evaluation software to build

your VM, there are optional steps for downloading Microsoftd
R2 so you can use that as your starting point. You can alternatively install Windows Server 2008 R2

yourself using your  own product key  so you do nothaveto  worry about the operating system on the
VM expiring after a certain amount of time.

Note thatt he requirements for  building out a SharePoint 2010 development environment are more
relaxed and have fewer requirements co  mpared to building out a SharePoint 2010 production
environment . Therefore,y ou should not rely on this document as your only resource when you are
installing SharePoint 2010 for production use. The following list of assumptions has been made

1 All software is installed and configured on a single server

1  DNS entries are mapped using a HOSTS file

1  The server is an Active Directory domain controller

1  All SharePoint worker processes will initially be configured to run under a single AD account

In addition to this  guide you can check out the Critical Path Training YouTube channel to see videos
demonstrating each step in this guide: http://www.youtube.com/users/CriticalPathTraining
The video series is  saved in this playlist: http://bit.ly/a9V068
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Section 1: Configure Hyper -V and Create a New Virtual Machine (VM )

This guide walks you through how to setup a virtual machineu s i ng Mi cr o\ o it rotsu dlyipzat i ¢
part of Windows Server 2008 & Windows Server 2008 R2. While there are other virtualization products available to
developers, this guide only covers Hyper-V. However, most of the steps in this guide can be applied to creating a
virtual machine with other virtualization products such as VMWare Workstation or VirtualBox.

Review to the following video for a walkthrough on the following steps: http://bit.ly/cPw8Xv.

1. Ensurey our computer hardware and software meet the following requirements.
a. Your computer is running a 64 - bit installation of Windows Server 2008 R2
b. Your computer has a connection to the Internet
c. Your computer has at least 6GB of RAM (8GB + recommended)
d. Your computer has at least 80GB of free disk space.
e. Your computer supports virtualization and has Hyper -V Services enabled.
f.  If you need more information on how to install and configure Hyper -V, you can read more
at http://www.microsoft.com/windowsserver2008/virtualization/install.mspx or

http:/bit.ly/9QGrswW
2. Launchthe Hyper -V Manager from the Windows Start menu.

a. Start » Administrative Tools » Hyper -V Manager . If you ar e using Hyper -V for the
first time there will be no existing VMs in the Virtual machines section

Actons
i ass Vit Machmes "
Vame - [Sws  [CPUlbape [Wenoy [ leme [Sma |

Mo vl machines wese foued on i server

Mo fem seected.

3. Create a new Virtual Network to connectto the Internet.

a. Inthe Actions pan on the right -hand side of the screen, click Virtual Network Manager
b. In the Virtual Network Manager dialog, create a new virtual network named External
c. Make surethe Connection type of the new virtual network is configured with a setting of

External and pointit toanetwork card on the host computer connected to the Inte  rnet .
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4. Create a new virtual machine to and prepare to  install Windows Server 2008 R2 Enterprise
a. Inside the left -hand side of the Hyper -V Manager, locate the node with the name of the
local host computer.  Right -click on this node and select New » Virtualm achine...
When you execute this menu, command, the Hyper -V Manager will launch the New Virtual
machine Wizard.
2 Fle Acon View Window Help
e #[m|
2 Hyper-V Manager
HemS New
Irl virtual Machine...
Hyper-V Settings.
virtual Network Manager...
Edit Disk...
Inspect Disk....
Stop Service
Remove Server
Refresh
View »
New Window from Here
Help
Displays the new virtual machine wizard.

b. Inthe Specify Name and location dialog, enter a name of WingtipServer . Note that
you can elect to store the files for the virtual machine in a different location. If possible,
create the VM on a local hard drive that is different from one which contains the files for
the host computerd6s operating system. It will al
if you are able to create your VM on a

[’ | Spedfy Name and Location

=
Before You Begn Choose a name and location for Bis virtual machine.
We recommend th that helps you easéy
- identify this virtual madhine, mxmmulhmlmzwsnmumm
Configure Netwarking Mame:  [wmnotoserver
Connect Virtual Herd Disk You can create s folder oc "
Tnstallstion Gptions it mane e o Itk b g o s v
Summary I Store the wival machine n a different location
Locaton: | E
. Ifyou plen of this select enauh free
o =4
cpeias [[Thes ]  Buh Caneed
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c. Inthe Assign Memory dialog, entera Memory value according to this list. Note that
your host machine requires at least 6GB of RAM.

i. If your host machine has 6GB of RAM, enter a Memory value of 4092 MB (4GB)
ii. If your host machine has 8GB of RAM, enter a Memory value of 6144 MB (6GB)
ii.  If your host machine has 12GB of RAM, enter a Memory value of 8192 MB (8GB)

d. Inthe Configure Networking dialog, use the drop down box to assign a Connection
value of External sothat your new VM can use the Virtual Network you created earlier.

e. Inthe Connect Virtual Hard Disk dialog, accept the default options to Create a virtual
hard disk . If possible, configure the Location sothatthe .VHD file forthe VM is created
on a solid state drive to improve your performance.

f. Inthe Installation Options dialog, choose the option to Install an operating system
fromabootCD \ DVD -ROM. To complete this step, you must have either a physical
DVD or an .ISO file with the installation files for the 64 - bit edition of Windows Server
2008 R2. If you have the installation files on a physical DVD, insert the DVD into a DVD
drive on the host computer and then select reference it from the drop down menu in the
Media section. If you have the installation files in .ISO file format, then select the radio
for Image file ( *.iso) and enter the path to the .ISO file.

g. Inthe Completing the New Virtual Machine Wizard dialog, review the settings and
click Finish to create the new VM.

h. Atth is point you should be able to see the new VM named WingtipServer in the Virtual
Machines section of the Hyper -V Manager.

5. Inspect and modify the setting for the new VM
a. Right-click onthe new VM named WingtipServer andselect Set t i n gosnédand.

b. Inspect the current setting in the Processor section for the Number of  logical
processors . The default value for this property is 1. However, increasing the number of
logical processors used by your VM can improve its performance. Therefore, you should
set the number of logical processors to the maximum value. Note that the maximum
number of logical processors is determined by the number of cores available on the host
computer.

BB Settings for WingtipServer [_ O =]
[wingtipserver | (¢
# Hardware ) Processor
= :f;;amwm You can modify the number of virtual processors based on the number of processors on
"= Boot from €D the physical machine. You can also modify other resource control settings.
B Memory Number of logical processars: [+ 7|
“oszie More about virtual processors
D processor o e —
o Bl 1€ Controller 0 You can use resource controls to balance resources amang virtual machines.
CoHardDive Virtual machine reserve (percentage): [
et e e
D;{D_DTVVE; s _server_2008_r2_... Virtual machine lmit (percentage): [ 100
Ef iiii:i”:ﬂ; Percent of total system resources: [=
- CEO,; '1'; Relative weicht: [0
- C(;M’Z Wore about resource control
= Diskette Drive 7Pvr:§E ;s: ;in::?::!lzssm features that a virtual machine can use. This improves
one the virtual machine's compatibility with different processor versions and older guest
£ operating systems, Select the scenarios you want to enable:
L] biame I~ Migrate to a physical computer with a different processor version
B I Run an older operating system, such as Windows NT
) Srepaot it ocaton
FC »{ ‘ atic Start Action
Ay e ———
o] o aoply

6. Start up the VM
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a. Right-click on the VM named  Wingtipserver and selectthe Conn e ¢ t menu. This will
launch the Virtual Machine Connection window for the VM.
Virtual Machines
Snapshot
Export...
Rename...
Delete...
Help
b. In the Virtual Machine Connection window, drop down the Action menu and select the
Start command.
i wingtipServer on localhost - Virtual Machine Connection
File | Action Media Clipboard View Help
Crri+Al+Delete Chrl+Ak-+End |
t Dawn,.. Chr+D
Save Chr+a
Pause Chrl+P
Reset, .. Chrl+R.
Snapshat.. Cerkn
Revert, Ctrl+E
I glipServer is tuned off
To start the virtual machine, select 'Start' from the Action menu
Status: Off
c. At this point you should be able to boot up the VM and see it  discover ins tallation files  for

Windows Server 2008 R2

. Now you can move on to the next step which describes

installing the operating system for Windows Server 2008 R2.
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Section 2: Install and Configure Windows Server 2008 R2

In this section, you will install and configure the operating system for Windows Server 2008 R2. Note that you should
obtain a product key and the product installation files if you plan to install Windows Server 2008 R2.

If you do not have a product key or you plan to share the VM you are building with those not covered under your
product key, you should download the free 180 day trial evaluation VM supplied by Microsoft as explained in
Appendix A: Download and Configure the Windows Server 2008 R2 Evaluation VM. Appendix A will lead you
through the steps of getting this free trial VM up and running so that you can use it as your starting point. If you
choose to use the free trial VM, you should now move to Appendix A and work through all its steps. After completing
the steps in Appendix A, you will be instructed to rejoin the steps below in this section.

Review to the following video for a walkthrough on the following steps: http://bit.ly/aeEpBg.

1. Before you begin, verify that you followed the steps in Se ction 1 to accomplish the following.
a. You created a new VM named WingtipServer.vhd

You have configured the VM with at least 4GB of RAM

You have configured the VM with the maximum number of  logical processors .

You have configured the VM with an external network card with an Internet connection.

You have configured the VM soitcan access the installation files for Windows Server
2008 R2 in either DVD or ~ *.iso file format .

2. Install the operating system for Windows Server 2008 R2

a. Start up the VM to beginthe setup programfor  Windows Server 2008 R2. After the setup
program for Windows Server 2008 R2 loads, it will prompt you with a dialog asking you to
select a language.  Accept the default of English and ¢ lick Install to continue.

©® 20 o

% Install Windows

e

—
Windows Server-2008

\

all:
S Englich (United States) 2
\

Enter your language and other preferences and click “Nex" to continue.

b. Atthe nextdialo g, clickthe Install now button to begin the installation.

% Install Windows

e /

.
Windows Server200

Install now ‘3

before installing Windows
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c. The next dialog instructs you to select the operating system you want to install. Select

the operating system named
with the x64 architecture

d. Agree to the licensing terms and click
e. Click on Custom (advanced)

Windows Server 2008 R2 Enterprise (Full Installation)
. Click Next to continue.

Next .

to select the type of installation.

f.  The next dialog asks you where you want to install Windows. Accept the default

configuration which uses a location of
Next to continue.

g. At this point you have given the Windows setup program

Disk 0 Unallocated Space as shown below. Click

enough information to install the

basic operating system. Setup program will now run for a while as it copies and expands

files and installs
catch up on email.

Windows features. You now have a few minutes to get a cup of coffee or

h. When the setup program completes, it will ask you to assign a new password for the

built -in Administrator account. Click
i.  Update the password for

j- When you have updated the
the update was successful. Click

3. When you log in, Windows Server automatically displ

window. Click the check box with the caption

the Close button. After you close this window, Windows Server will display the

Admi nistrator

Administrator
OK to complete the installation of the operating system.

OK to continue.
accountto Passwordl
password, you will get a confirmation that

ays the Initial Configuration Tasks
Do not show this wind ow atlogo n and then click
Server Manager

[CETETTT— ol
ﬁ Perform the folowng tasks to configure this server £ 'M‘hmgwsservern
1) e =
~
A "
2 W e
52 tte s
o Lo
T st
B siarn
T~ Dot show this wendow at logon Ocse

4. You should now looking  at the Server Manager.
the Windows Start menu using Start

Tianaze (WP SOQIIE)

i oy DHCP, v ensbied

Prodct I Hotactvated

I 05 not om me e comaoe atogen

» Administrative Tools

If the Server Manager is not open, launch it from
» Server Manager

=lolx|

Server Manager (WIN-SIZKQIBHIMS)
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5.

6. Rename the computer name of the VM
a.

b.

b.

Configure the Administrator account so that its password does not expire

Inside the Configuration node of the Server Manager , navigate to Local Users and
Groups » Users (as shown in the following screenshot) and locate the local

Administrator account. Right -click on the  Administrator account and click  Properties

E Server Manager

File  Action Help

s |22 XE = H=

ja Server Manager (WIN-3RGLEQQ3T
_5_1'...- Roles

Features

E Diagnostics

View

Set Password..

= fﬁ’é Configuration .~ T Tt |account f'or guest access to t..
g Task Scheduler All Tasks 3
i Windows Firewall with Advz T
& Services
&5 WMI Contrl FETENE
= #% Local Users and Groups
| Users -
| Groups Help |

25 Storage

Inthe Administrator Properties

dial og, unselect the option for
password at next logon

User must change
and select the option for

Password never expires . Click OK.
to WingtipServer

Inthe Server Manager , navigate to the top

-level node to display the
page. Click Change System Properties

Serve r Summary

[E.. Server Manager

£
Computer Nams | Hardwere | Advanced | Remte |

-] x|
File Acton View Help
&=z
= Server Manager (WIN-HNB91NNAB2G)
* Roles
Features
R Diagnostics . Get an overview of the status of this server, perform top management tasks, and add or remove server roles and features.
it Configuration &
2 storage L
X) Server Summary Server Summary Help =
~| Computer Information A Activate Windows
i :
Full Computer Name: WIN-HNBS INNAB2G 1% Change System Froperties
E’ Wiew Network Connections
Workgroup: UACHESROLEY R Configure Remote Desktop
Local Area Connection 2: IPv4 address assigned by DHCP, IPv6 enabled Sy Configure Server Manager Remote
Management
Remote Desktop: Disabled
Server Manager Remote Disabled
Management:
Product ID: Not activated
I™' Da not shaw me this consale at logon
On the Computer Name tab of the System Properties dialog, click the Change button.

1y Vindowsuss thefoloming domation o ety yockcomader
onthe netwak

Conputergescrpten: [

Forexample: "I Production Sever” o

8 ke

Fulcompuerrame:  WINHNBSTNNABZS

Wetgow WORKGROUP

Topmans s compder o chage s donen - Qrange.
(o) sean| ey
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c. Enter a new computer name of WingtipServer and click OK. Note there is no need to
change the Workgroup because you are going to create a new domain later .

x|
*You can change the name and the membership of this

computer. Changes might affect access to network resources.
More information

Computer name:

Wingtip Server
Full computer name:
WingtipServer
More
Member of
" Domain:
* Workgroup:
IWORKGROUP
ok | Cancd |
d. After changing the computer name you will be prompted to restart the VM. Choose OK to
restart. After the VM has restarted, log in again using the same credentials as before.
7. Disable Windows Firewall and Enhanced Securi  ty Configuration
a. Inthe Server Manager, navigate to the top -level node to display the Server Summary
page. Inside the Security Information section locate the links for Go to Windows

Firewall and Configure IE ECS

~| Security Information # Go to Windows Firewall
Windows Firewall: Public: On & Configure Updates
*4 Check for New Roles
il Wy . ji il il Wy -
Windows Updates: Install updates automatically using Windows Update Zh Run Security Configuration Wizard
Last checked for updates: Today at 6:23 AM '14?\0 Configure IE ESC
Last installed updates: 8/10/2009 6:11 AM
IE Enhanced Security Configuration On for Administrators
5C): On for Users

b. Click on Configure IE ECS link. Disable Enhanced Security Configuration for both
Administrators and Users by selecting the  Off radio buttons and click OK.

c. Nowc lickthe Go to Windows Firewall link to display the page for the Windows Firewall.
Click on the Windows Firewall Properties link at the bottom of the Overview  section.
d. Inthe Domain Profile tab of the Windows Fire dialog, change the Firewall state
property setting from On to Off . Clickto Apply button to save your changes. Once you
have turned off the firewall in the Domain Pr ofile tab, go to the  Private profile tab and

the Public profile tab and follow the same steps to disable the firewall for these profiles
as well. Click OK to dismiss the Windows Firewall dialog once you have turned off the
firewall for all three profiles.

8. Enable the Windows Server  Feature s for the Desktop Experience and the PowerShell
Integrated Scripting  Environment

a. In Server Manager, choose Add Feature  to bring up the Add Features Wizard dialog
b. Selectthe feature  Desktop Experience

www.CriticalPathTraining.com Page 10 © 2010 Critical Path Training, LLC
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Add Features Wizard x|
= |
= Select Features
Clir
Select one or more features to install on this server,
Confirmation Features: Description:
Progress ] .NET Framework .3.5.1Feab.|res . =] %ﬁ%iﬂ?&?ﬂe;:\ztures
Results "] Background Inteligent Transfer Service (BITS) Media Player, desktop themes, and
[] BitLocker Drive Encryption photo management. Desktop
[] BranchCache Experience does not enable any of the
[] Connection Manager Administration Kit Windows 7 features; you must
Desktop Experience manually enable them.
|: DirectAccess Management Console
|: Group Policy Management
[] 1nk and Handwriting Services
] Internet Printing Client b
|: Internet Storage Name Server
] LPR Port Monitor
[] Message Quewing
] Multipath I/
] Metwork Load Balandng
] Peer Name Resolution Protocol
] Quality Windows Audio Video Experience
|: Remote Assistance
"] remote Differential Compression
# [ Remote Server Administration Tools i
ﬂ [}
More about features
< Previous | Next > | Install I Cancel I

c. Note when you first click the checkbox for the Desktop Experience , the wizard will
prompt you with the following dialog to add support for Ink and Handwriting Services.
Click the Add Required Features button to continue.

d. Scroll down the list of features in the Add Features Wizard dialog and s elect the
feature Windows PowerShell Integrated Scripting Environment (ISE)

e. Note when you first click the checkbox for the Windows PowerShell Integrated
Scripting Environment (ISE) , the wizard wi Il prompt you with the following dialog to
add support for .NET Framework 3.5.1 Features. Click the Add Required Features
button to continue.

f.  Now that you have selected these two features for installation, click the Next button on
the Add Features Wizard d ialog to continue with the install. The next screen you will
ask you to Confirm Installation Selections. Click the Install  button.

g. When you see the Installation Results screen, the Add Features Wizard informs you a
computer restart is required. Click Close button to dismiss this dialog.

h. The final dialog of the  Add Features Wizard prompts you to restart the VM. Click Yes to

Configure the DisableLoopbackCheck
a.

begin the rebooting process.

After the VM has restarted,
installation process

login again as  Administrator
for Desktop Experience will automatically continue and complete.

(Microsoft KB #896861)

registry setting

Launch the Windows Registry Editor. To do this click

then click OK.

. Once you login, the feature

Start , click Run , type regedit

, and

www.CriticalPathTraining.com
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Typethe name of a program, folder, decument, or Internet

= resource, and Windows will open it for you.

Open: Iregadit j

%) This task will be created with administrative privileges.

0K I Cancel | Browse... |

b. In Registry Editor, locate and then click the following registry key:

HKEY_LOCAL_MACHINESYSTEM CurrentControlSet \ Control \Lsa

c. Right -click Lsa, point to New, and then click DWORD (32 -bit) Value
% Registry Editor =10) x|
File Edit View Favorites Help
W = AT [ Type [ Data [
w- | L Bxpand Los nec o7 (value not set)
SN  ew 3 Key 0%00000000 (2)
- v String Value 0%00000000 (1)
E] 1 $ Delete Binary Value msv1 0
] Reniame ( 00 30 00 00 00 20 00 00
- M QWORD (64-bi 0x00000000 (1)
H LM Export 0x00000000 (0)
& NP Parmsssonss Multi-String Value
B N Expandable String Value 0x00000000 {0
w- L N Copykey NW 0x00000000 (0)
B || NetworkPror 7] ivilegeauditing REG_BINARY ili]
B |l Nis 8| LimitBlarkPasswo... REG_DWORD 0x00000001 (1)
Bl Nodelnterfa ) LsaPid REG_DWORD 0x00000214 (532)
B b Nsi 4| NoLmHash REG_DWORD 0x00000001 (1)
- L, PCW ab|notification Pack... REG_MULTI_SZ scedli rassfm
- | PP #4|ProductType REG_DWORD 0x00000007 (7)
B Jy Power ﬂtﬂresnimnonymous REG_DWORD 0x00000000 (0)
- [ Print i’;lj]restictanunymuu... REG_DWORD 0x00000001 (1)
-+ |, PriorityCont 8| SecureBoot REG_DWORD 0x00000001 {1)
- | ProductOpti E_E'JSecurity Packages REG_MULTI_SZ kerberos msv1_0 schannel wdigest tspkg pku2u
Bl |, SafeBoot
B | ScsiPort
[+~ |, SecurePipes
B~ | SecurityPron
- |, ServiceGrou
B [, ServiceProvi
W e
‘Cumputer\.HKEY_LOCAL_MhCHINE\SYSTEM\CurreﬂiﬁontolSEt\Conho\\.Lsa 4
d. Type DisableLoopbackCheck ,and then click Enter .
e. Right -click DisableLoopbackCheck , and then click Modify .

f. Inthe Value data text box,type 1, andthenclick OK.

Edit DWORD (32-bit) Value X|
Walue name:
| DisableLoopbackCheck
Walue data: Base
|‘| i Hexadecimal

i~ Decimal

Cancel

g. Quit Registry Editor
10. Enabled Remote Desktop  for your VM
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a. Inthe Server Manager |, navigatetothetop -level node to display the Server Summary
page. Inside the  Computer Information section, locate and click the link for Configure
Remote Desktop . In the Remote tab of the System Properties dialog, select the last
option for  Allow connections only from computers running Remote Desktop with
Network Level Authentication . Click OK to save changes and dismiss the System

Properties  dialog.

x|

'Computer Namel Hardware | Advanced Remote

~ Remote Assistance

= Sllaw Eemate Sssistatce contections to this computer

Advanced.. |

~ Remote Desktop
Click an option, and then specify who can connect, f needed.
" Dont allow connections to this computer

" Allow connections from computers running any version of
Remote Desktop (ess secure)

* Allow connections only from computers running Remote
Desktop with Network Level Authentication {more secure)

Help me choose Select Users... |
ok | Cancsl | ooy |

b. Now you should be able to connect through an RDP session. Many people prefer an RDP

connection instead of the Hyper -V console. If you want to connect to this VM thr

ough an

RPD connection, bring up a command prompt and run the ipconfig command to

determine the IP address that has been assigned to your VM. Now you should be able to

connect to your VM using RDP from another computer by using this IP address.
11. Ifyou have a product key for Windows Server 2008 R2, use it to activate Windows.

a. Inthe Server Manager, navigate to the top -level node to display the Server Summary

page. Click Activate Windows

b. You will be prompted to enter your product key. Enter your product key and click to

button to activate Windows. After a few seconds, your VM should be able to connect to a

Microsoft site and successfully activate Windows.

Install Active Directory Domain Services

Now you will promote your VM to a domain controller and create a new domain named wingtip.com

1. Add and configure the role for Active Directory Domain Services

a. Launch Server Manage r and selectthe Roles node. You should see there are no roles

have been installed
b. Clickthe Add Roles link to start the Add Roles Wizard.
On the Before you begin page, click Next

Onthe Server Roles page, Select Active Directory Domain Services . If will are
prompted with a dialog which asks to install Microsoft .NET Framework 3.5.1 , click the
Add Required Features button to dismiss this dialog. Click Next to advance the Add

Roles Wizard.
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the Use advanced Mode installation

@ Active Directory Domain Services Installation Wizard

check box and click Next.

x|

Welcome to the Active Directory
Domain Services Installation
Wizard

This wizard helps you install Active Directory Domain
Services (AD DS) on this server, making the server an
Active Directory domain controller. To continue, click Next

™ Use advanced mods installation

Leam more about the additional options that are
available in advanced mode installation

More about Active Directory Domain Services

< Back Neat > Cancel |

h.  When you see the

Operating System Compatibility

page, click Next .

Building a SharePoint 2010 Virtual Machine Version1l. 6
Add Roles Wizard x|
ﬁ}j Select Server Roles
Before You Begin Select one or more roles to install on this server.
Roles: Description:
Active Directory Domain Services ] Active Directary Certificate Services E::o[:ier:r:foorm[]aiir;zianbsoegiocgjseég
Confirmation on the network and makes this
P [[] Active Directory Federahon Services information available to users and
TOIEss [ Active Directory Lightweight Directory Services network administrators, AD D5 uses
Results [] Active Directory Rights Management Services domain contr:llers t°_t9t"’de network
" N USEers access [0 permitied resources
L Application Server anywhere on the network through a
[ DHeP Server single logon process.
[ DNS server
|:| Fax Server
[] File services
|:| Hyper-V
[ Network Policy and Access Services
|:| Print and Document Services
[ Remote Desktop Services
[] web Server (115)
] windows Deployment Services
[] windows Server Update Services
More about server roles
< Previous | MNext = I Install I Cancel |
e. On the next page of the wizard, ¢ lick Next which will bring you to the Confirm
Installation Selections page. Click Install
f.  After Active Directory Domain Services has been instal led, you will see the Installation
Results page in the Add Roles Wizard as shown below. Click on the link with the big long
caption of Close this wizard and launch the Active Directory Domain Services
Installation Wizard (dcpromo.exe)
On the first page of the Active Directory Domain Services Installation Wizard , click
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i.  The next page asks you to Choose a Deploym ent Configuration , select the option to
Create a new domain in a new forest and click Next .
j-  The next page asks you to Name the Forrest Root Domain . Enter wingtip.com into
the FQDN of the forest root domain textbox for the root domain and click Next .
k. The next page asks you to Set Forest Functional L evel . Using the dropdown list,
change the setting to Windows Server 2008 R2 and click Next .
I.  The next page asks you to set Additional Domain Controller Options . You should be
able to accept the default option s as shown below. Click  Next .
Bl Active Directory Domain Services Installation Wizard x|
Additional Domain Controller Options
Select additional options for this domain controller.
[ DNS server
¥ Global catalog
[~ Read-only domain controller (RODE]
Addtional information:
The first domain controller in a forest must be a global catalog server and ﬂ
cannot be an
'We recommend that you install the DNS Server service on the first domain
contraller.
=
Mare about additional domain controller options
< Back Next > Cancel |
m. You might be prompted with the dialog shown below providing a warning that This
computer has dynamically assigned IP address(es) . This is not a problem when you
are running your development environment on a domain controller . Click Yes to dismiss
the dialog.
6_1 Static IP assignment 1[
Ir' . T L (es)
This computer hag at least one physical network adapter that does not have static IP address(es)
assigned to its IP Properties. If bath IPv4 and IPv6 are enabled for a network adapter, both IPv4 and
IPvE static IP addresses should be assigned to both IPv4 and IPv6 Properties of the physical netwark
adapter. Such static IP address(es) assignment should be done to all the physical network adapters for
reliable Domain Mame System (DNS) operation,
Do you want to continue without assigning static IP address(es)?
<) Yes, the computer will use an IP ically igned by a DHCP server
(not recommended).
<3 No, I will assign static IP to all physical network
E@] More about configuring TCP/IP and DNS Client settings.
n. At this point the wizard will prompt you with a dialog information you a delegation for the
DNS Server cannot be created because it cannot find the authoritative parent zone. This
is not a problem because the wizard wil | automatically configure the DNS of the VM to

point to itself. Click on the Yes button to dismiss this dialog.
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@ Active Directory Domain Services Installation Wizard

A delegation For this DMNS server cannot be created because the

l % authoritative parent zone cannot be Found or it does not run
windows DS server, If you are inkegrating with an existing DNS
infrastructure, you should manually create a delegation ko this
DMS server inthe parent zone to ensure reliable name resolution
From outside the domain "wingtip.com”, Otherwise, no action is
required.

Do you wank to conkinue?

Yes Mo |
0. The next page asks you to set values for Location for Database Log Files and
SYSVOL . Accept all the default values by clicking Next .
p. Thenext page asks you to provide and confirm a password for Directory Services
Restore Mode Administrator Password . Add a password of Passwordl  and click
Next .
g. Thenextpageisthe Summary page which should show the values below. Click Next to

start the process of  configuring the new Active Directory domain

r.  The wizard will display the dialog below to show you the progress of the configuration
process. You will be required to reboot when the configuration has been completed.
Check the option for ~ Reboot on completio n and then wait for the configuration to
complete and the machine to reboot.

ctive Directory Domain Services Instalition Wiz

Services This pr
e e spters

o
tha o st

st Grous Pobcy Mansgsmert Conesk.

o |

¥ Reboot on competion

s. After the VM reboots, you should logon using the domain account
WINGTIP \ Administrator . The password should still be Password1

Configure Windows Update

As the final part of this step, you will configure Windows Update.

1. Select Start » All Programs » Windows Update
2. First, disable Windows Update from running automatically:
a. Clickthelink Change Settings

b. Underthe Important Updates list, select Never check for updates (not
recommended) . This isn6t what you would do in a productio
development machine it is ok.

3. Now update the server. First select the Check for Updates link.

a. Windows Update will the report how many updates are avai lable . Select all important and
recommended updates. Thenc  lick the Install Updates button.

b. If prompted, select | accept the license terms for any updates that require it.

c. When Windows Update completes, itds a good idea to go

server has rebooted, login again.
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Section 3: Install SQL Server 2008 R2 Enterprise

In this section, you will install the Enterprise edition of SQL Server 2008 R2. Below we provide a link which will allow
you to download a free trial version which will expire after 180 days. If you have a licensed version of SQL Server
2008 R2, you can alternatively install that so that the software does not expire after 180 days.

Review to the following video for a walkthrough on the following steps: http://bit.ly/aOWYdZ.

1. Follow these stepsi fyou plan on using the free trial version of SQL Server 2008 R2 . Note that
this free trial version is set to expire in 180 days after installation. If you have a registered
vers ion of SQL Server 2008 R2 through a subscription to MSDN or TechNet or by other means,
you can install that instead of the free trial version in order to having the software expire.

a. Inthe browser, navigate to the page at the link below.

http://technet.microsoft.com/en - us/evalcenter/ee315247.aspx or http://bit.ly/9IrVeO

b. Follow the instructions to download the 64 - bit edition of SQL Server 2008 R2 . The
download is a self -extracting file named SQLFULL_x64 ENU.exe

Once downloaded, double click SQLFULL_x64_ENU.exe to begin the extraction process
After downloading, extract the contents .

Note: If you are using a licensed copy, you will likely have an *.ISO file which you can mount to the DVD Drive of the
VM.

2. Logon to the VM and begin the installation of SQL Server 2008
a. Logontothe VM as Wingtip \ Administrator
b. Open the Widows Explorer navigate to the DVD drive.
c. Doubleclickon setup.exe to begin the installation process.

3. The setup process should now show the following window. Click the Installation link on the left -
hand side of the window and then click the link which reads New SQL Server stand -alone
installation or add features to an existing installation

4. The setup program will then check to make sure there were no problems with the setup rules.
Once passed, click OK.

% SOL Server 2008 R2 Setup [_[O]x]
Setup Support Rules

Sehup Support Rules identify problems that might ocour when you nstal 5GL Server Setup suppart files. Fallures must be corrected
before Setup can continue,

Setup Suppork Rules Operation conpleted, Passed: 7, Falled 0. Warning 0. Skipped 0.

|

Hide details << Re-run

Wigw detalled report

F
£

Rule Status
Mirimum operating system version Passed

Setup administrator Passed

Restart computer Passed

Windows Management Instrumentation (W) service Passed

Consistency validation for SQL Server registry keys Passed

Lang path names to files on SQL Server installation media Passed

REEERER

SQL Server Setup Product Incompatibiity Passed

oK Cancel
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5. There are several windows at the beginning of the installation process that you should click Next
to advance the ins tallation process. At the Product Key  page, selectthe Enterprise Evaluation
or plug in your license key and click Next to continue.

When prompted on the License Terms dialog, click | accept the license terms and click Next .
The next page isthe  Setup Sup port Files page. Click Install to continue.
When you getto the  Setup Support Roles page of the setup wizard, the installation process

runs tests to make sure your VM meets the requirements. Your VM should pass all tests and the
only warning you should rec  eive is that you are installing SQL Server 2008 on a domain

controller.  You can ignore this warning. Click Next to continue.
& SOL Server 2008 R2 Setup H =
Setup Support Rules
Setup Support Rules identify problems that might occur when you install SQL Server Setup suppart files, Failures must be corrected
before Setup can continue.
Setup Support Rules Operation complsted, Passed: 10, Failed 0, Warning 1. Skipped 0,
Feature Selection
Installation Rules Hide detalls << | Re-run |
Disk Space Requirements Wiew detailed repart
Error Reporting
Installation Configuration Rules Rul| Ruls Stilius
Ready to Instal Lf) Fusion Active Template Library (ATL) Passed
Installation Progress @ Unsupported SQL Server products Passed
Complete @ Performance counter registry hive consistency Passed
@ Previous releases of SQL Server 2008 Business Inteligence Develop... |Passed
@ Previous CTP installation Passed
@ Consistency validation For SQL Server registry keys Passed
_}l Computer domain contraller ‘Warning
@ Microsoft .NET Application Security Passed
(2 |Edtion wowed platfarm Passed
@ wwindows PowerShell Passed
@ wwindows Firewall Passed
< Back. | Mext = | Cancel | Help |
4
9. Onthe Setup Role page, select SQL Server Feature Installation and click Next .
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8 S0L Server 2008 R2 Setup [_[O]
Setup Role

Click the SQL Server Feature Installation option to individuslly select which Feature components to install, or dick a feature role bo
install a specific configuration.

Sefup Support Rules % SOL Server Feature Installation
Setup Role Install SGL Serwer Database Engine Services, analysis Services, Reporting Services, Integration Services, and
Feature Selection other features.
Installation Rules " 5QL Server PowerPivot for SharePoink
Disk Space Requirements Install PowerPivot For SharePoint on a new or existing SharePoint 2010 server to support PowerPivot data
i g access in the farm, To use the New Server option, SharePaint must be installed but not configured.
Installation Configuration Rules Add PowerPivot for SharePoint ko INew Server j
Ready to Install i~ All Features ‘With Defaults
Installation Progress Install all Features using default walues for the service accounts.
Complete
< Back | Mext = | Cancel | Help |
4
10. Whenyou gettothe  Feature Selection page, selectthe following features and click Next to

continue (also refer to the following screenshot for reference)
a. Database Engine Services
i. SQL Server Replication
ii. Full-Text Search

b. Analysis Services

c. Reporting Services

d. Business Intelligence Development Studio
e. Management Tools 1 Basic

i. Management Tools - Complete
f.  Microsoft Sync Framework
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%% 50L Server 2008 R2 Setup

Feature Selection

Select the Enterprise features to install.

= =]

Setup Support Rules
Setup Role
Feature Selection

Description:

Database Engine Services

Server features are instance-
aware and have their own

registry hives. They support

¥| SQL Server Replication
Q i multiple instances on a computer.

Full-Text Search
nalysis Services
Reporting Services
Shared Features
Business Inteligence Development Studio
[ client Tools Connectivity
D Integration Services
[] dlient Tools Backwards Compatibility
[[] dlient Taols SDK
[[] QL Server Books Online
Management Tools - Basic
Management Tools - Complete
D 5QL Client Connectivity SDK
Microsoft Sync Framework
Redistributable Features

Installation Rules

Instance Configuration
Disk Space Reguirements

Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Error Reporting

Installation Configuration Rules
Ready to Instal

Installation Progress

Complete

Select all | UnselectAIIl

Shared feature directory: |C: \Program Files\Microsoft SQL Servery |
Shared feature directory (x86): IC: \Program Files (x86)\Microsaft SQL Server) |
< Back Next = Cancel | Help

y

11. Click Next onthe
12. There is nothing to change on the
13. Click Next onthe Disk Space

Installation Rules dialog.

Instance Configuration page. Click Next to continue.

Requirements dialog.
501 Server 2008 R2 Setup =l
Disk Space Requirements

Review the disk space summary for the SQL Server Features you selected,

Setup Support Rules

Setup Role 53 Drive C: 5455 MG required, 52709 MG avaiable
Feature Selection System Drive (C:{): 2956 VB required

DiskLisage Summary:

Shared Install Directory (C t|Program FlesWicrosoft SQL Server): 998 ME required
Instance Directory (C: Program Files|Micrasoft SQL Server: 1504 MB recpired

Installation Rules
Instance Confiquration

Disk Space Requirements
Server Configuration

Dakabase Engine Corfiguration
Analysis Services Confiquration
Reporting Services Configuration
Error Reporting

Instalation Corfiguration Rules
Ready to Instal

Instalation Progress

Complete

<ok | net» Cancel Help

14. The next page isthe  Server Configuration
Server Agentto be  Automatic
all SQL Server instances
account (NT AUTHORITY

page. Change the StartUp Type
. Click the button with the caption of
. When the dialog appears

\ SYSTEM ) and click OK.

setting for the SQL
Use the same account for
to select a user account, select the System
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Use the same account for all 0L Server 2008 R2 services

Specify a user name and password For all SOL Server service accounts,

fccount Mame: [T AUTHORITY\SYSTEM | B_rowse...l

Password: I
o |

NOTE: In a real production environment, SQL Server 2008 R2 processes should be configured to run under a
dedicated service account and not under the System account.

15. After you have completed the previous step, the Server Configuration page should appear like
the one shown below.  Now click on the Collation tab.

& SOL Server 2008 R2 Setup H=
Server Configuration

Specify the service accounts and collation configuration,

Setup Support Rules Service Accounts |c°natim |
Setup Role
- Microsoft recommends that you use a separate account For sach SQL Server service.
Installation Rules Service Account Name Password ‘ Startup Type
Instance Configuration St Server Agent NT ALUTHORITY|SYSTEM =
Disk Space Requirsments SGL Server Database Engine T AUTHORITVISYSTEM futomatic x|
Gerver Configuration 5QL Server Analysis Services MT AUTHORITV\SYSTEM automatic x|
Database Engine Configuration SGL Server Reporting Services NT AUTHORITYISYSTEM futomatic x|
Anal S Confi i
e SGL Fulktext Filter Dasmon Launcher | NT AUTHORITY\LOGCAL 5., Manual

Reporting Services Configuration

SQL Server Browser MT AUTHORITVILOCAL 5. Disabled j
Error Reporting

Installation Configuration Rules

Ready to Instal Lse the same account For all SQL Server services |

Installation Progress

Complete
< Back lext = ancel el
Bi | et | [ | Help |¢
16. Onthe Collation tab, you will see default collation settings for both the Database Engine and
for Analysis Services . Eachsettinghasa Cu st o mi 2uatén to its right. Click the
Cust omi batén foreach of these two settings and fill out the resulting dialog with the
collation setting shown in the screenshot below . This step ensures you have the best collatio n

setting for SharePoint 2010 which is LATIN1_General with the options for ~ Case Insensitive
(Cl) , Accent -sensitive (AS) , Kana -sensitive (KS) and Width -sensitive (WS)
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17.

18.

19.

Select the collation youwould like to use:

{* Windows collationdesignator andsort order

Collation designator ILatinl_GeneraI j
[” Binary [ Binary-code point
[~ case-sensitive ¥ Kana-sensitive

¥ Accent-sensitive ¥ width-sensitive

(= SQL collation, usedfor backwards compatibility

Collation description:

Latin1-General, case-nsensitive, accent-sensitive, kanatype-insensitive, width-insensitive for
Unicode Data, 5QL Server Sort Order 52 on Code Page 1252 for non-Unicode Data

0K I Cancel

Once you have changed the collation, the Server Configuration dialog should look like the one
below. Click Next to continue

% SQL Server 2008 R2 Setup [_[o]x]

Server Configuration

Specify the service accounts and collation configuration.

Setup Support Rules Service Accounts  Collation
Setup Role
Feature Selection B

Installation Rules Latin1_General_CI_AS_K5_WS Customize...

DRI Latini-General, case-insensitive, accent-sensitive, kanatype-sensitive, width-senstive

Disk Space Reguirements

Server Configuration Analysis Services:

Database Engine Configuration Nl o
S A Latin1-General, case-insensitive, accent-sensitive, kanatype-sensitive, width-sensitive

Reparting Services Configuration
Error Reporting
Installation Configuration Rules

Ready to Install

Installation Progress

Complete

< Back Cancel | Help |¢

The next page isthe  Database Engine Configuration page. Specify WINGTIP \ Administrator
as a SQL Server administrator by clicking the Add Current User button at the bottom of the
page. After the page  looks like the one below, click on the FILESTREAM tab so that you can
make changes there.
Onthe FILESTREAM tab ofthe Database Engine Configuration page, select the options for
Enable FILESTREAM for Transact -SQL access and Enable FILESTREAM for file I/O
streaming access . Click Next to continue.
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20.

21.

22.
23.

24.

%% SOL Server 2008 R2 Setup M=l B3

Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directaries.

Setup Support Rules Account Provisioning | Data Directaries  FILESTREAM

Setup Raole
Feature Selection V¥ Enable FILESTREAM Far Transact-SQL access
Installation Rules ¥ Enable FILESTREAM For file 1f0 streaming access
Instance Configuration

ek S Feuaans Windaws share name: IMSSQLSER\-‘ER

Server Configuration ™ allow remote clisnts to have streaming access ko FILESTREAM data
Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Etror Reporting

Installation Configuration Rules
Ready ta Instal

Installation Progress

Complete
< Back | Mext = | Cancel | Help |
A
On the Analysis Services Configuration page, specify WINGTIP \ Administrator asan
Analysis Services administrator by clicking the Add Current User button at the bottom of the
page. Click Next to continue.
% SOL Server 2008 R2 Setup [-[O[x]
Analysis Services Configuration
Specify Analysis Services administrators and data directories,

Setup Support Rules Account Provisionind | Data Directoties

Setup Role

Feature Selection Specify which users have administrative permissions for Analysis Services,

Installation Rules Analysis Services

Instance Configuraton GRS

Disk Space Requirements. Analysis Services,

Server Configuration

Database Engine Configuration

Analysis Services Configuration

Reporting Services Configuration

Error Reporting

Installation Configuration Rules

Ready to Install

Installation Progress

Complete

st | oo
<Back | Hext > e Help |4

On the Reporting Service Configuration page, select the last option to Install, but do not
configure report server . Click Next to continue.
At the Error Reporting page, click Next .
At the Installation Configuration Rules page, verify that your VM passes all tests. Click Next
to continue.
On the Ready to Install page, click Install to begin the installation. The installation wil | take

somewhere between 5and 3 0 minutes depending on your hardware performance.
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25. Whenyou gett othe Complete page you are finished with the installation. Click the Close
button.
%% SOL Server 2008 R2 Setup H=]
Complete

‘our SQL Server 2008 R2 installation completed successhully,

Setup Support Rules Summary lag file has been saved to the Following location:
Setup Raole Ci\Program Files\Microsoft SQL Servert]00iSetup Bookstrapilogiz0100424 114546

1Summary WingtipServer 20100424 114546.txt

Feature Selection

Installation Rules Information about the Setup operation of possible next steps:

Inst Confi i
M IES (CCTE T 5 @ Your SQL Server 2008 R2 installation completed successfully,
Disk Space Requirements

Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Error Reporting

Installation Configuration Rules
Ready to Instal

Supplemental Infarmation:
Installation Progress

Complete The following notes apply ta this release of SOL Server only, j

Microsoft Update

For information about how ko use Microsoft Update to identify updates For SGL Server 2008 R2, see the Microsoft
Update Web site at http:ffqo.microsoft. comfulink?LinkId=105409.

Samples
By default, sample databases and sample code are not installed as part of SQL Server Setup. To install sample

databases and sample cade For non-Express editions of SOL Server 2008 R2, see the CodePlex Web site at
0.microsoft. comyFwlinki?LinkId=87845, Ta read ahout support For SGL Server sample databases and -

Close | Help

A

26. Now, you have completed the installation of SQL Server 2008 R2. Now you can optionally install

the Adventure Works sample databases by going through Appendix B: Create th e Sample
Adventure Works Databases . Note that you can go through the steps of Appendix C right now
or you can wait until you have completed the remaining  sections.
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Section 4:Install and Configure  SharePoint Server 2010

Now it is time to install SharePoint Server 2010. You will begin by installing the released version of WCF Data
Services for .NET 3.5. The installation of this component is required to make REST-based Web services work
properly in SharePoint Foundation. Next, you will install SharePoint Server 2010 and create a new farm. Within this
farm you will create and configure a new Web application and configure several of the service applications supplied
by SharePoint Server 2010.

Review to the following video for a walkthrough on the following steps: http://bit.ly/a9Vo68.

1. Install WCF Data Services

a. Inthe browser, navigate to the download page using the URL below . Note that the
download page is titled with the old name which is ADO.NET Data Services Update for
.NET Framework 3.5 SP1 for Windows 7 and Windows Server 2008 R2

http://www.microsoft.com/downloads/details.aspx ?FamilylD=3e102d74 - 37bf - 4cle - 9da6 -
5175644fe22d  or http://bit.ly/9R2ju8

b. Locate and download the file Windows6.1 -KB976127 -v6 -x64.msu
c. Double -clickon Windows6.1 -KB976127 -v6 -x64.msu to run the update.

In the next step you will create a new user account named SP_WorkerProcess that will serve as the identity for the
worker pool processes used by SharePoint Server. You will create this account as a domain account in the
WINGTIP directory as to simulate a production environment. Note, however, that this setup document reduces
complexity by using a single user account to configure all SharePoint Server worker processes while a true
production environment will likely employ multiple user accounts so that various Web Applications like Central
Administration could have a unique identity.

2. Create new user account in Active Directory  for SharePoint Worker Process identity

a. Launch the Active Directory Users and Computers from the Windows Start menu
Start » Administrative Tools » Active Directory Users and Computers

b. Navigate tothe Users node. Right click on this node and execute the New » User menu
command as shown in the screenshot below.

Create new account named SP_WorkerProcess by filling out the dialog as shown.
Give the new user account a password of Passwordl

e. When you are done you sh  ould be able to verify you can see the new
SP_WorkerProcess account inside the  Users node.

f.  Configure access to SQL Server 2008 R2 for this account.

i. Open Start » All Programs » SQL Server 2008 R2 » SQL Server
Management Studio

ii. When prompted, connect to th e server WINGTIPSERVER  using Windows
Authentication

iii. Expandthe Security node, right -click Logins and select New Login
iv. Forthe Login Name enter WINGTIP \ SP_WorkerProcess

v. Selectthe Server Roles page onthe left -hand portion ofthe Login 7 New
dialog. Select the following roles and click OK:

1. dbcreator
2. public
3. securityadmin
3. Download the SharePoint Server 2010 installation files and make them available to the VM
a. Inthe browser, navigate to the page at the link below.

http://technet.microsoft.com/en - us/evalcenter/ee388573.aspx or http://bit.ly/bcz4S7
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b. Download the file named SharePoint Server .exe to hard drive of host computer.
c. Extractth e setup files into a location where they are accessible to your VM. For example,
if you downloaded SharePoint Server .exe tothe c:\ Install directory on the local hard
drive of your host computer, you can extract the SharePoint Server 2010 setup files into
a child directory named  c:\ Install \ SharePoint2010 by running the following command
from the command line.
c: \Install \SharePoint Server .exe /extract.c: \Install \ SharePoint2010
d. Double -click the setup. hta file in the installation folder to launch the installer utility:
Microsoft* A
I SharePoint Server 2010
Review hardware and software requirements
Read the installation guide
Read the upgrade guide
[nstall
Install software prerequisites
Install SharePoint Server
4. Runthe SharePoint 2010 Products Preparation Tool
a. Click the link Install software prerequisites under the Install  group.
b. Click Next atthe welcome screen to install the SharePoint Server prerequisites.
Note:Your virtual machine wil/ need I nternet access to

internet connection you can download and manually install all the prerequisites using the information on this link:
http://technet.microsoft.com/en-us/library/cc262485.aspx or http://bit.ly/9DyhIN.

5.

6.

After running  SharePoint 2010 Products Preparation Tool , reboot the machin e and then log
inagainas WINGTIP \ Administrrator

Install SharePoint Server 2010 Enterprise

a.

Inside the top -level directory of the SharePoint Server install files, locate
setup.exe  to launch the installation program

When prompted, e nter your product key for SharePoint Server 2010.
Accept terms of Agreement

Inthe Choose afile  location dialog, accept the default setting and click Install Now to
complete the installation of SharePoint Server 2010 Enterprise.

and double -click
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e. When installationis comp leted , you are prompted  with a checkbox labeled Run the
SharePoint Products and Technologies Configuration Wizard now . Make sure this
checkbox is checked and ¢ lick Close to begin this wizard.

7. Use the Configuration Wizard Create the Config uration Database and Central Administration
Web application using the SharePoint Products and Technologies Configuration Wizard
On the Welcome to SharePoint Products page, c lick Next to continue.
b. A dialog will ask you whether it is OK to stop IIS and a few other services. C lick Yes on

this dialog to continue with the configuration process.

c. Onthe Connectto a server farm page, Select Create a new server farm and click
Next to continue.

SharePoint Products Configuration Wizard (- [T =]

Connect to a server farm

Aserverfarmis a collection of two or more computers that share configuration data. Do youwantto
connectto an existing serverfarm?

("'annecttoanexistingserverfarm
i+ Create a new server farm

9

d. The next page isthe  Specify Configuration Database Settings page. Fill in these
settings with these value.
Database server:  WingtipServer
Database name:  Wingtip_ConfigDB
Username: Wingtip \ SP_WorkerProcess
Password: Passwordl
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SharePoint Products Configuration Wizard (- [T =]

Specify Configuration Database Settings

All serversin aserver farmmust sharea configurationdatabase. Typethe databaseserver anddatabase
name, If the database does not exist, it will be created. To reusean existing database, the database must be
empty. Foradditional information regarding databaseserver security configuration and network access
pleasesee help.

Database server |Wingﬁpserver

Database name: IWingﬁp_ConﬁgDB

Specify Database Access Account

Select an existing Windows account that this machine will always useto connect to the configuration
database. Ifyour configurationdatabase is hosted onanotherserver, youmust specify a domainaccount.

Typethe usernamein the form DOMAIN\User_Name and passwordforthe account.

Username: IWING‘I‘IP\,SP_WorkerProcess

Password: |.uuuu

< Back | Mext = Cancel

e. One you filled in the configuration database settings, click Next to continue.

f. Thenext pageisthe Specify Farm Security Settings page which asks you to add and
confirm a passphrase. Add and confirm a pass phrase value of Passwordl and click Next
to continue.

SharePoint Products Configuration Wizard [_[=]x]

Specify Farm Security Settings
Please entera new passphrasefarth intProducts farm. Thi hrase s usedto secure farm
configuration data andis required for each serverthatjoins the farm. The passphrase can be changed after
thefarm is configured.

Passphrase: [oessronse

Canfirm passphrase: [seeeeenes
9|

<Back | Next > I Cancel |

g. On the Configure SharePoint Central Administration Web Application page, select th e
option to  Specify port number and add a port number value of 9999 . Leave the
Configure Security Settings authentication provide settings at the default value of

NTLM . Click Next to continue.
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SharePoint Products Configuration Wizard M= E3

Configure SharePoint Central Administration Web Application

A SharePoint Central Administration Web Application allows you to manage configuration settings for a server
farm. The first server added to a server farm must hast this web application. To specify a part numberforthe
web application hosted on this machine, check the boxbelow and type a number between 1 and 65535. If
you do not specify a port number, a random one will be chosen.

¥ Specify port number: Igggg

Configure Security Settings

Kerberos is therecommended security configuration to use with Integrated Windows authentication. Kerberos
requires special configuration by the domain administrator. NTLM authentication will work with amy
application poolaccountand the default domainconfiguration. Show memore information.

Choose an authentication provider for this Web Appliction.

i+
" Neagotiate (Kerberos)

< Back | Mext = I Cancel

h. Review your configuration settings in the Completing the Shar ePoint Products
Configuration Wizard page. C lick Next to begin the configuration
SharePoint Products Configuration Wizard M= B3

Completing the SharePoint Products Configuration Wizard

Thefollowing configuration settings will be applid:

m Configuration Database Server |Wingti|:|5erver |
m Configuration Database Name |Wingﬁ|:|_ConﬁgDB |
» Hostthe Central Administration Web Ap pliation |YES |
m Central Administration LURL |htu::j,fwingﬁpserver:9999,f |
m Authentication provider |NTLM |

Click Nextto apply configuration settings.

Advanced Settings |

< Back Cancel
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i.  SharePoint will now begin configuring itself which should take 5 -10 minutes depending on
the performance of your hardware. When you are done, you will a page with the title of
Configuration Successful
j.  Click the Finish button and you will be directed to a page in Central Administration at the
URL of http://wingtipserver:9999/ admin/adminconfigintro.aspx . This page starts the

Farm Configuration Wizard
8. Configure the farmbs wsgngthd Eam @opfigdration Wizdardo n s

a. Thefirstdialog of the Farm Configuration Wizard asks you whether you want to
participate inthe  Customer Experience Improvement Program . Select the option  No,
I dondt wi sh t oangdelickt OKe tb goatihue

b. The next page of the wizard asks How do you want to configure your SharePoint
farm? Select the option  Yes, Walk me through the settings using the wizard. Click
Start the Wizard to continue.
{2 Initial Farm Configuration Wizard - Windows Internet Explorer
3/ [E htio:/fwingtipserver:995/_admin/adninconfigintro.aspx7scenarioid=adninconfigge) =] | 43| % | [ ing P~
.7 Favorites |{.;, & suggestedsites v @ Web Slice Gallery +
[7] nitial Farm Configuration Wizard M- ~ 7 g=h - Page- Safety- Tools~ @~
WINGTIP\administrator =
Site Actions ~
P §F§rePoint2010 Central Administration » Configure your SharePoint farm
o This wizard will help you configure your SharePoint farm.
@
How do you want to configure
your SharePoint farm? Yes,_walk me through the Start the Wizard
This wizard will help with the initial configuration of my farm using this rt the Wizar
configuration of your SharePoint wizard.
farm. You can select the services to
use in this farm and create your first
site.
You can launch this wizard again No, I will configure everything
from the Configuration Wizards myself. Cancel
page in the Central Administration
site.
=l
Done [ [ [ [ [ [ [ Trustedsites | Protected Mode: Off [7 - [Rw0% ~
c. Nextpage ofthe Farm Configuration Wizard asks you to select a service account for
running the farmés service applUseeaidtiigonanaged Sel ect t he
account and make sure the domain account WINGTIP \ SP_Wo rkerProcess s selected.
You do not need to change anything in the Services section because you can accept the
default selections. Click Next to continue.
Now the Configuration Wizard is going to run for a while .
d. In addition to provisioning the f ar nsérgce application s, the Farm Configuration Wizard

also creates a new Web Application using the URL of the machine name
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(http://WingtipServer
root. Giveita Title of Wingtip Test Site
and click OK to continue.

2 §F§rePoint2010 Central Administration » Configure your SharePoint farm

Use this page to create a new top-level Web site.

Title and Description

Type a title and deseription for your new site. The tte wil be displayed on
each page in the site,

Web Site Address
Spedify the URL name and URL path to create a new site, or choose to create

& sit= st a specific path.

To add a new URL Path go to the Define Managed Paths page.

Template Selection

A site template determines what lists and features will be avalable on your
new site, Select a site template based on the descriptions of each template
and how you intend to use the new site. Many aspects of a site can be
astomized after creation. However, the site template cannot be changed
once the site is aeated.

e. Nowyou are finished with the

] §ﬁ§rePointzolo Central Administration » Configure your SharePoint farm

This ¢ the Farm Confi Wizard.

Central
Administration
) Details of this SharePoint farm:
Application Management
. ) Site Title: Wingtip Test Site
System Settings Site URL: http://wingtipserver
Monitoring . .
Service Application
Backup and Restore

) and asks you if you want to create a new site collection at the

, Sele ct the site template named Team Site

) ¥
Ilkelt  Tags &
Notes
skp ok Cancel |
Title:
[wingtip Test Site
Description:
URL:

hitp://wingtipserver] / -

Select a template:
Collaboration | Meetings | Enterprise | Publishing | Custom

Blank Site
Document Workspace

Group Work Site
Visio Process Repository

A site for teams to quickly organize, author, and share information. It
provides a document library, and lists for managing announcements, calendar
items, tasks, and discussions.

skip | ok | cancel |

Farm Configuration Wizard

. Click Finish

) 9
Ilikelt Tags &
Notes

. sices Web Service Application
Security . & Service Application
Upgrade and Migration .
General Application .
Settings -
Configuration Wizards .
. and Load Balancer Service Application
. ollection Service Application
. Service Application

« User Profile Servic ation
Business Data Connectivity Service Application
Search Service Application

Click Finish to continue to the SharePoint Central Administration page where you can continue configuring other settings for your farm

To return to this wizard, or access additionally installed wizards, click "Configuration Wizards' in the left navigation pane.

f.  Whenthe Farm Configuration Wizard
of the Central Administration appl

Finish

completes, it will redirect you to the home page

ication.

Post -Installation Configuration of SharePoint Server 2010

9. You have now completed the basic installation of SharePoint Server 2010 and you have created

the configuration database to establish a new farm.
not automatically turned on by default.

a. On the home page of
Manage services on this server

Central Administration

Now you will turn on two services that are

, locate and click the link with the caption
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& SharePoint 2010 Central Administration F i
TlkeRt  Tags &

Notes
7]

Central
Administration

Application Management
System Settings
Monitoring

Backup and Restore
Security

Upgrade and Migration

General Application
Settings

Configuration Wizards

Application Management
Manage web applications
Create site collections

Manage service applications
Manage content databases

Monitoring

Review problems and solutions
Check job status

view Web Analytics reports

Security
Manage the farm administrators group

System Settings
" thic £

Manage services on server |

T
Configure alternate access mappings

Backup and Restore
Perform a backup

=i Restore from a backup

Perform a site collection backup

Upgrade and Migration

Convert farm license type

Resources

There are currently no favorite links to display.

To add a new link, click "Add new link".

4 Add new link

#

4, Configuration Wizards
‘Cj\

Cenfigure service accounts Check product and patch installation status

Check upgrade status

e General Application Settings
Configure send to connections

Configure content deployment paths and jobs
Manage form templates

b. Onthe Services on Server page for WingtipServer, you must start two services named
Claimsto  Windows Token Service and Microsoft SharePoint Foundation
Sandboxed Code Service . You can do this by clicking on the Start link in the Action
column over to the right of the service name.

p §F‘§rePoint2010 Central Administration » Services on Server: WingtipServer & 1
) Use this page to start or stop instances of services on servers in the farm Ilike It Tﬁg: &
otes

2]

Central
Administration

Server: | WingtipServer - View: | Configurable -
Application Management
System Settings Service status Action
Monitoring
Backup and Restore Access Database Service Started Stop
Security Application Registry Service Started Stop.
Uparade and Migration | Business Data Connectivity Service Started Stop
General Application Central Administration Started Stop
Settings Claims to Windows Teken Service Stopped Start
Cenfiguration Wizards Document Conversions Launcher Service Stopped Start
Document Conversions Load Balancer Service Stopped Start
Excel Calculation Services Started Stop
Lotus Notes Cennector Stopped Start
Managed Metadata Web Service Started Stop
Microsoft SharePoint Foundation Incoming E-Mail Started Stop
Microsoft SharePoint Foundation Sandboxed Code Service Stopped Start
Microsoft SharePGint Foundation SUDSCripEon SEtings Service Topped Start
Microsoft SharePoint Foundation Web Application Started Stop
Microsoft SharePoint Foundation Workflow Timer Service Startad Stop
performancePoint Service Started Stop
PowerPoint Service Started Stop
Search Query and Site Settings Service Started Stop
Secure Store Service Started Stop

10. At this point you can optionally install the Microsoft Office Web Applications so that you add the
functionality required to open and edit Word documents and PowerPoint slide decks through the
browser. To accomplish this work through the steps of Appendix D: Install the Office Web
Applications and then return here and co ntinue on at the next step.

Note: Installing the Microsoft Office Web Application is not required when building a VM for any Critical Path
Training courses.

Create a New Web Application

Now you will create and configure a new Web Application at the URL of http://intranet.wingtip.com. You must
begin by configuring DNS with Windows Server 2008 R2 and then you will use the Central Administration application
to create and configure the new Web Application.

1. Now itdés time to c on foicapfigure URDINECh ase t http://mtgaset.wingtip.com
they are redirected to the local loopback address . Since this is a development workstation (and
not a production server), you will use a shortcut to redire ct DNS names using an Imhost file.

SO
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The biggest benefit to using the Imhost file approach for configuring DNS names is that your DNS settings will not be
affected by changes to the VM's network card such as switching between a dynamic IP address and a static IP
address. In fact, the DNS setting will work fine even when your VM has no Internet connection. This is the only
approach you should use when configuring DNS on a demo machine.

a. Inthe Windows explorer, navigate to the directory at
Locate the file which has the name

C:\ Windows\ System32 \ drivers
hosts and no file extension.

| services 6/10/2009 2:00 PM File 18 KE

L2 Local Disk (C:)

1 etc [_ O[]
P
g( e ‘ j. - Computer - Local Disk (C:) + Windows ~ System32 + drivers + et v 23 | searchetc
Organize * | Open  New Folder =+ [0 @
7 Favorites (e Date modified Type ~ | Size I |
i
) Libraries | networks 6(10/2009 2:00 PM Flle 1KB
| prokocol 6/10/2009 200 Fils 2KB
1% Computer
i
i

1| Imhwosts.sam 6110/2009 2:00 PM SAM File 4kB

€ Natwork

hasts Date modiied: 4{24/2010 8:41 P Date created: 7/13(2009 7:34 PM

File Size: 228 bytes

b. Open the hosts file using NOTEPAD.EXE. Delete the entire contents of the hosts file and

replace it with the following text.
# Wingtip DNS Settings for testi

127.0.0.1  intranet.wingtip.com
i intranet.wingtip.com

1%7.0.0.1 extranet.wingtip.com

extranet.wingtip.com

127.0.0.1 www.wingtip.com
1 www.wingtip.com

c. Save your work.

lhnst; - Notepad
File Edit Format Yiew Help

ng and development

[_[D[x]

# Wingtip DNS Settings for testing and development
127.0.0.1 intranet.wingtip.com

o1 intranet.wingtip.com

127.0.0.1 extranet.wingtip.com

N extranet.wingtip.com

127.0.0.1 winw. wingtip. com

N winw. wingtip. com

|

Kl

-

t 4

d. Verify the new DNS setting works properly by bringing
and running the DOS ping command on the address of

up a Windows command prompt
http://intranet.wingtip.com

\etc \.
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[+, Administrator: C:\Windows' system32' cmd.exe

C:x>ping intranet.wingtip.com

Pinging intranet.wingtip.com [:

:1: time<{ims

time{ims

: time<{ims
Reply from ::1: time<{lims
Ping statistics for :-:1:
Packets:
Approximate round trip times i
Minimum = Bms.
Con,

:11 with 32 bytes of data:

Sent = 4, Received = 4, Lost = B (Bx loss>.
milli-seconds:
Maximum = Bms. Average = Bms

2. Create anew Web Application

a. Navigate to
running, launch it from

the home page of the
Start

at the URL of

Central Admin
» All Programs

http://intranet.wingtip.com

istration application. If it is not already
» Microsoft SharePoint 2010 Products

» SharePoint 2010 Central Administration

b. Inside the Application Management
Manage web applications

c. Make sure the Web Application
hand side of the Ribbon

Web Applications Management

Site Actions -

Browse

to navigate to the
tab is selected.

section, click on the link with the caption of
Web Application Management  page.

Click the New button on the very left

Web Applications

o

Mew | Extend Delete General

Settings
ntribute

Mew Web Application

Create a new SharePoint web
application which, in turn, creates a
new II5 web site with backing
databases that can be used for
creating new SharePoint sites.

hManage Features

hManaged Paths
Authentication Self-Service 5i

Service Connections Providers Creation
Manage Securii
it - 280

1t Central Administration v

Backup and Restore

d. The Create New Web Application

dialog appears. Note that this is a very tall page and

you will have to scroll down to see and fill out all the information required to create a new

Web application. Ther
should leave the default setting of

e are no changes required in the Authentication section because you
Classic Mode Authentication
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reate New Web Application

. . . . . e
Warning: this page is not encrypted for secure communication. User names, passwords, and any —
other information will be sent in clear text. For more information, contact your administrataor.

0K Cancel
Authentication
¥ Claims Based Authentication
Select the authentication for ' Classic Mode Authentication

this web application.

Learn about authentication.

e. Scrolldowntothe IIS Web Site section. S elect the optionto  Create a new IS web
site and entera Name of Wingtip Intra net . Entera Port of 80 . Forthe HostHeader

setting, add a value of intranet.wingtip.com .Add a Path value of
c:\ inetpub \ WingtipIntranet . When you are done, you entries should look like the ones
below.

IS Web Site

© Use an existing 115 web site
Choose between using an

existing 115 web site or create a I Default Web Site =1
new one to serve the Microsoft

SharePoint Foundation @ Create a new IIS web site

application. Name

If you select an existing 115 web IWi”Qtip Intranet

site, that web site must exist on
all servers in the farm and have

the same name, or this action Port

will not succeed. |8 0

If you opt to create a new 115 Host Header

web site, it will be automatically Iintranet.wingtip.com

created on all servers in the

farm. If an IIS setting that you Path

wish to change is not shown KR P—

here, you can use this option to IC.\lnetpub\WlngtlpIntranet
create the basic site, then

update it using the standard II5

tools,

f.  Scroll down tothe Security Configuration section and fill it out so it looks like the
following screenshot
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Security Configuration
Kerberos is the recommended Authentication provider:
security configuration to use
with Integrated Windows . Megotiate (Kerberos)
authentication. Kerberos &
requires the application poal MTLM
account to be Network Service Allow Anonymous
or spedal configuration by the
domain administrator. NTLM  ves
authentication will work with &
any application pool account * No
and the default domain Use Secure Sockets Layer (S5L)
configuration.
. Yes
If you choose to use Secure
Sockets Layer (S5L), you must % No
add the certificate on each
server using the IIS
administration tools, Untl this is
done, the web application will
be inaccessible from this IIS
web site.
g. Scroll down to the Application Pool section. Select the option to Create new application
pool and enter an Application pool name of SharePoint Default App Pool . Make sure

you configure the ident
WINGTIP \ SP_WorkerProcess

Application Pool

Choose the application pool to
use for the new web
application. This defines the
account and credentials that will
be used by this service.

‘fou can choose an existing

application pool or create a new
one.

h. Scroll down to the

Database Server setting has a value of
a descriptive name of
at the default value of

Database Name and
Authentication

Use of the default database
server and database name is
recommended for most cases.
Refer to the administrator's
guide for advanced scenarios
where specifying database
information is required.

Use of Windows authentication
is strongly recommended. To
use SQL authentication, spedfy
the credentials which will be
used to connect to the
database.

 Use existing application pool

ity for the new application pool with the
account as shown in the following screenshot.

| Classic .NET AppPool ()

% Create new application pool
Application pool name

|SharePoint Default App Pool

Select a =ecurity account for this application pool
 predefined

[l Configurable

| WINGTIP\SP_WorkerProcess x|
Register new managed account

Database Name and Authentication
WingtipServer
WingtipIntranet_ContentDB
Windows authentication

Database Server

IW\ngtipSErvEr
Database Name
|W\ngtipIntranet_CDntentDB

Database authentication

' Windows authentication (recommended)

” 3QL authentication
Account

Password

section. Make sure the
. Next, give t he content database
. Leave the authentication settings

i.  Atthis point, you have configured all the necessary information to create the new Web

application at

http://intranet.wingtip.com

default values. Scroll down to the bottom of the page

. You can leave all other settings with their

and select No for the option for the
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Customer Experience Improvement Program . Click OK to provision the new Web
Application.

After SharePoint Server provisions the new Web application, it displays the following
dialog. Click on the blue link with the caption of Create Site Collection

The next page provides input controls for you to enter information about the new site

collection. Entera  Title of Wingtip Intranet . Leave the URL with its default setting so
that the new site collection is created at the root of the Web application. Selec t Team
Site as the site template for the top -level site.

Create Site Collection

oK Cancel

Title and Description .

Title:
Type a title and description Wingtip Intranet
for your new site. The title I S
will be displayed on each Description:
page in the site, ﬂ

[

Web Site Address

URL:
Specify the URL name and http:Hintranet.wingtip.ooml.u" - I

URL path to create a new
site, or choose to aeate a
site at a spedific path.

To add a new URL Path go
to the Define Managed
Paths page.

Template Selection
Select a template:

A site template determines
what lists and features will
be available on your new

Collaboration | Meetings | Enterprise | Publishing | Custom

site, Select a site template Blank Site

based on the descriptions of Document Workspace |
each template and how you Blog

intend to use the new site. Group Work Site

Many aspects of a site can Visio Process Repository

be customized after
creation. However, the site
template cannot be changed
once the site is created.

A site for teams to quidkly organize, author, and share information. It
provides a document library, and lists for managing announcements, calendar
items, tasks, and discussions.

Configure the Primary Site Collection Administrator setting with the user account
WINGTIP \ Administrator
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Primary Site Collection
Administrator User name:
Specify the administrator for WINGTIF\administrator ; | 9./ 59
this site collection. Only one
user login can be provided;
security groups are not
supported.
Secondary Site Collection
Administrator User name:
Optionally specfy a | 9./ [ 5%
secondary site collection
administrator, Only one user
login can be provided;
security groups are not
supported.
Quota Template
Select a quota template:
Select a predefined quota lm
template to limit resources
used for this site collection. Storage limit:
Number of invited users:
To add & new quota
template, go to the Manage
Quota Templates page.
oK Cancel I
m. Click OK to begin the provisioning process.
n. After the new site collection has been create d, clickthe OK button.
0. You will now see a list of SharePoint Web applications
Configure Internet Explorer 8 for Testing
To make life easier, there are a few things you can do to configure Internet Explorer when browsing SharePoint
2010 sites.
1. Navigate to the Wingtip Intranet site.
a. Go to the top -level site by navigating to the URL of http://intranet.wingtip.com . Click
OK to dismiss and go back to central admin. You will be prompted for alo gin and
password. Enter  Wingtip \ Administrator and a password of Passwordl . Youshould be
able to see the home page of the site running inside the Web application you just created.
o » ‘0
Welcome to your site!
»
=
5
L] G e [ roaced e OF RS
2. Configure Internet Explorer for automatic Windows authentication . The purpo se of this step is to
eliminate the need to enter a user name and password when you navigate to this site or any
other site within the Web application at http://intranet.wingtip.com
a. Inside the Internet Explorer , drop downthe Tools menu and select Internet Options
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b. Inthe General tab ofthe Internet Options dialog, entera Home page address of
http://intranet.wingtip.com . Click the Apply button to save your setting.
c. Navigatetothe Security tab ofthe Internet Options dialog. Select the zone named
Local Intranet . Click the Sites button to configure the Local Intranet zone.

d. When you click the Site button in the previous step, the Internet Explorer will display the
follow ing dialog. Click on the Advanced button

e. The next dialog allows you to add one or more URLSs that will be added to the Local
Intranet zone. Add the URL of http://  * .wingtip.com

f.  Click Close to dismiss the firstdialog .Next click OK to dismiss the next dialog which

should bring you back to the original Internet Options dialog. Click OK to save all your
changes.
3. Now close the Internet Explorer and then reopen it. You should be able to see the home page of
the new Team Site you create d at http://intranet.wingtip.com without having to enter any

login information.
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Section

5:Install  Microsoft Office 2010 Client Applications

In the next step, you will install the 32-bit version of the Microsoft Office 2010 client applications. Be sure to
download and install the 32-bit version and not the 64-bit version. The reason for selecting the 32-bit version over
the 64-bit version is because the 64-bit version does not include some things you will want in your SharePoint
environment, including the SharePoint list Data Sheet view.

Review to the following video for a walkthrough on the following steps: http://bit.ly/dfONIJ.

Install Office 2010 Pro

fessional Plus

1.

Download the installation software

from Microsoftdés downl oad

site.

Note: You can use the trial version of Office Professional Plus 2010 available from Microsoft
(http://technet.microsoft.com/en-us/evalcenter/ee390818.aspx or http://bit.ly/cfrOOP) or you can use a licensed

copy you have acquired from an MSDN subscription or within your organization.

a. Download Office Professional P lus 2010 to your host machine in a location where it
will be accessible to the VM.
b. Inthe VM, navigate to the location of the installer and double click it
c. Accept the default installation options by clicking the Install Now button.
d. When installationis co mplete, you will see the following dialog. Click OK.
2. Launch Microsoft Word and make sure it starts without problems.
a. Start Microsoft Word 2010 from the Windows Start menu
Start » All Programs » Microsoft Offi  ce » Microsoft Word 2010
J Accessories ;I ——
, Administrative Tools J
. ADO.MET Data Services v1.5 CTP2 \_)
. Maintenance
, Microsoft Office pa
@ Microsoft Access 2010 (Beta) Gl
|‘._—(| Microsoft Excel 2010 {(Beta) . E—
m Microsoft InfoPath Desigrier 2010 (Beta,
[T Microsoft InfoPath Filler 2010 (Beta) Compute
[N] Microsoft OneNote 2010 (Beta) s
| O Microsoft Outiook 2010 (Beta) T
|£—| Microsoft PowerPaint 2010 (Beta)
|E Microsoft Project 2010 (Beta) P
|E| Microsoft Publisher 2010 (Beta)
Microsoft SharePoint Designer 2010 (Be FereserEres
@ Microsoft SharePoint Workspace 2010 (£
IE Micrasoft Visio 2010 (Beta) Administrative Tools 3
[ Microsoft Word 2010 (Beta)
, Microsoft Office 2010 Tools Help and Support
| Microsoft Office 2010 Developer Resources
, Microsoft SharePoint 2010 Products LI Run...
4 Back Windows Security
I |search programs and files @J Log off >|
[Frsa 3% B
b. The firsttime you launch Microsoft Word 2010, y ou will see the following dialog . Select

Dondt

m eh&nges c and click OK.
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Help Protect and Improve Microsoft Office a

Cig
[w]

Use Recommended Settings
€ 1ol mportant nd , Widows and Offer ptional Office and
ecknlne forslutrs o prolens,Gourload les s helo system problems, automatically
Updats Offce contant, snc helpimprove Offce

Install Updates Only
o el
uuuuu

, Windows and Offer Office and

tant a
b

Don't make changes
' Choosing tis option could expose your computer to security threats,

c. Close Microsoft Word 2010.

Install SharePoint Designer 2010

1. Download the 32 -bit version of SharePoint Designer from the following URL

http://www.microsoft.com/downloads/details. aspx°Fam ilylD=d88a1505 - 849b - 4587 - b854 -
a7054ee28d66 or hitp://bit.ly/94poZ4

a. Click Download to get SharePoint Designer 2010.

b. Once downloaded, run the SharePointDesigner .exe file and install SharePoint Designer
2010.

2. Launch SharePoint Designer 201 0 and make sure you can connect to the site at
http://intranet.wingtip.com

a. Start SharePoint Designer 2010 from the Windows Start menu.
Start » All Programs » SharePoint » SharePoint Designer 2010

b. Clickthe Open Site button inthe top left  -hand section of main work area.

c. Open the site at the path of http://intranet.wingtip.com . Note that the Open Site
dialog can be a bit confusing because it displays all the folders inside the site. All you
need to do is enter an URL of http://intranet.wingtip.com inthe Site name textbox and
then click the Open button to open the site in the SharePoint Designer 2010.

d. Verify that the site  at http://intranet.wingtip.com opened correctly in the Sh arePoint

Designer 2010 and that you can navigate around the various types of SharePoint objects.
e. Close SharePoint Designer 2010.

Install Visio 2010

3. Download Visio 2010 from the trial download link provided by Microsoft
(http://technet.microsoft.com/en - us/evalcenter/ee390821.aspx or
http://bit.ly/IMHYYS ) or you can use a licensed copy you have acquired from an MSDN
subscription or within your orga nization.

4. When prompted, accept all the default options.
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Configure Office 2010 Trust Settings

1. When installing Office 2010 on the same machine as SharePoint Server 2010 you need to do one
more thing to get the Office clients to save files to the server. You need to disable the Protected
View in Office.

e.

Launch Word 2010 : Start » Microsoft Office » Microsoft Word 2010
Using the ribbon select  File » Options

Select the Trust Center  from the list of options and click the Trust Center Settings
button.

Select the Protected View and uncheck all the  Pro tected View  options on this dialog,
leaving only the  Enable Data Execution Prevention mode checked.

2=

Trust Center

Trusted Publish
fusted Publishers Protected View

Trusted Locations . . . " . " "
Protected View opens potentially dangerous files, without any security prompts, in a restricted mode to help minimize harm

to your computer, By disabling Protected View you could be exposing your computer to possible security threats,

[~ Enable Protected View for files originating from the Internet

Add-ins [~ Enable Protected View for files located in potentially unsafe lacations (&

[" Enable Protected View for Outlook attachments (i

Trusted Documents

ActiveX Settings

Macro Settings Data Execution Prevention
|
Protected View [¥ Enable Data Execution Prevention moda

Message Bar
File Block Settings

Privacy Options

Cancel 1y

Click OK multiple times to close the dialogs and exit out of Word 2010.
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Section 6: Install Visual Studi 0 2010

In this step you will install the Visual Studio 2010 which includes the SharePoint Tools.

Review to the following video for a walkthrough on the following steps: http://bit.ly/aDT3hj.

1. Download the ISO file for MicrosoftVi sual Studio 2010 Ultimate

a. Download the Visual Studio 2010 Ultimate trial from the following URL, or use your own
licensed copy of Visual Studio 2010 Ultimate:

http://www.microsoft.com/downloads/details.aspx?familyid=06A32B1C -80E9 -
41DF -BAOC -79D56CB823F7 or http://bit.ly/bErhyl
b. Extract the downloaded files and attach the extracted *. ISO to the VM.

2. Install Microsoft Visual Studio 2010
a. Run setup.exe

b. Clickonthelinkto Install Microsoft Visual Studio 2010

c. Click Next to move past this dialog.

d. Selectthe op tion | have read and accept the license terms and click Next .

e. Onthe Selectfeatures to install dialog , select the Custom option and click Next .

BB Microsolft ¥isual Studio 2010 Ultimate Setup - Options Page

Microsofts .
nﬂVmual Studio 2010 Uttimate ~ Setup

Select features to install: Feature description:

Ol This aption all to select which fest .
Complete Yisual Studic installation. Install all ® OpHon allows you o ssict which features yau want to

install.
programming languages and tools.

[c] Custom

Select which programming languages and tools
tainstall o the next page

[

Product install path:

C:%Program Files (86)\Miciosoft isual Studio 10.0% Browse..

Disk space requirements:

Volume | Disk Size | Availabls | Fequied | Femaining |
[ 47.9GB 200 GE 76GE 12.4 GB
E: 931BGE M24GE  Obytes 4424GB

(ElEVIDuSl Mextx I Cancel |

f.  On the next dialog where you select the features to install, there is only one thing you will
change from the  default settings.  Unselect the checkbox es for Visual F# , Visual C++
Graphics Library , Dotfuscator Software Services I Community and Microsoft SQL
Server 2008 Express Service . You are actually free to install everything except SQL
Express; the things you removed are not necessary for SharePoint development.

Unselecting the SQL Express option is required because the VM already has a n installati on
of SQL Server 2008 R2 Enterprise. If you attempttoinstall the SQL Server 2008 Express
Service, it could cause a failure in the Visual Studio 2010 installation process. Click

Install  to begin the installation process.
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W, Microsoft Visual Studio 2010 Ultimate Setup - Options Page o ] 5|

Mi:rgso!l' .
tﬂ Visual Studio 2010 Ukimate  Setup

Select features to instalk: Feature description:

[ERCIE Microsoft Visual Studio 2010 Uttimate ;I

7] % Visual Basi Microsoft Visual Studio 2010 Ultimate _

5 < Microsoft Visual Studio 2010 Ultimate is an expansion of the
K Visual C++ Visual Studio product line to include new lifecycle tools for
é\ﬁm Cit project managers, architects, developers, testers, and

operations managers to manage the software development
>< Visual F# process.

é\ﬁsua Web Developer
“.[]'% Graphics Library

-[] L Mi ft Office Developer Tools (x64) _I

-[[1'% Dotfuscator Software Services - Community

-]’ Microsoft SQL Senfer 2008 Express Service Feature install path:

%'“M SharePoint Developer Tools C:\Program Files &x86)\Microsoft Visual Studio 10.0% Browse... |

Disk space requirements:
Volume | Digk Size | Awvailable | Required | Remaining |
[0S 43.9GB 255GB 42GB 21.3GB
1 | i

Restore Defaults | < Previous | Install I Cancel |

g. Inthe first phase of Visual Studio 2010 installation, the installer program installs a beta
version of the .NET Framework 4.0. Afterwards , the in staller program asks you to reboot
your computer. Click the Restart  button to reboot the VM.

h. After the VM has rebooted ,loginas WINGTIP \ Administrator . Once you are logged in,

the Visual Studio 2010 installation will automatically resume. This second phas e of the
installation process will take between 10 and 20 minutes to complete. When the
installation process is complete, you should see the Success dialog. Click Finish to end

the installation process.
3. Install the Visual  Studio 2010 SDK.
a. Gotothe following download page for the SDK

http://www.microsoft.com/downloads/details.aspx?Family|D=47305cf4 -2bea -
43c0 -91cd -1b853602dcc5 or http://bit.ly/ckFjiN

b. Click the download link to download the installation file named VsSDK_sfx.exe

c. Onthe VM, double -clickon VsSDK_sfx.exe  to begin installation of the SDK. When you
gettothe Welcome to Setup screen, click Next .
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BB Microsoft Visual Studio 2010 SDK Setup M= B3

Wwel to Set 3 Wacipsoftr .
cloome fo selp O# Visual Studio 2010
DK

‘welcome to the Microzoft Yisual Studio 2010 SDE installation wizard. Microsoft Yisual Studio 2010
SDK containg documentation and tools that will allow vou to easily extend Microzoft Yisual Studio
2010, including Microsoft Visual Studio 2000 Team Foundation Server. This wizard will guide you

through the installation process.

Mext | Cancel I

d. Accept the terms of the licensing agreement and clock Next .

page, leave the folder default setting and click Next to start

e. Onthe Destination Folder
the SDK installation.

f.  Whenyou see the Setup Complete dialog, click Exit to finish the installation.

4. Test connecting to the local farm using the Visual Studio 2010 SharePoint Tools

a. Launch Visual Studio 2010 from the Windows Start menu :
Start » All Programs » Microsoft Visual Studio 2010 » Microsoft Visual Studio
2010 - ENU
l&lnne-«e:zxah-: - B
g e
Search programs and files l,:] Logaff ¥
[Frstat 3, 5 &% 00O @) VSN,
b. The first time you launch Visual Studio 2010, it will display the following dialog to Choose
and then

your default environment settings . Select General Developer Settings

click the Start Visual Studio button.
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Wacrpscitr .
O® Vistal Studio 2010 Utimate

Before you begin using the application for the first time, you need to specify the type of
development activity you engage in the most, such as Yisual Basic or Yisual C#. This information
is used ko apply 5 predefined collection of settings ko the development environment that is
designed for your development activity,

‘You can choose ko use a different collection of settings at any time, From the Tools menu,
choose Import and Export Settings and then chonse Reset all settings.

IV Migrate my eligible settings from a previous version and apply them in addition to the
default settings selected below,

Choose your default environment settings:

General Development Settings Description;

Project Management Settings Configures the environment to closely match
Wisual Basic Development Settings earlier wersions of the application to provide an
“isual C# Development Settings expetience that is alveady Famiiar to you. Select
Wisual C++ Development Settings this collection of settings if you develop in more
“isual F# Development Settings than one programming language.

web Development

"Web Development {Code Only)

Start Yisual Studio I Exit Wisual Studio I

c. When Visual Studio starts up, locate the Serv er Explorer window on the left -hand side of
the main window of Visual Studio 2010. If you do not see the Server Explorer, drop down
the View menu and selectthe  Server Explorer menu command.

Start Page - Microsoft Visual Studio (Administrator)
Be Bt Yew Dehg Tean Oxie Achviechse Tegt Toos Agiee Mindom beb
155 xR

* Jomrtpoze x

QO Visual Studio 2010 Utimate

-3

d. Locate the right -most button on the toolbar of the Server Explo rer windows and click it to
add a new SharePoint connection.

Server Explorer O

=] 14| % 1 5a

[EE}Data Connections
T4 Servers
§Hi SharePoint Connections

e. Inthe Add SharePoint Connection dialog, enter the URL http://intranet.wingtip.com
and click OK.
Add SharePoint Connection

To connect to a new SharePoint site, enter the path to the
server or the site,

| http: ffintranet. wingtip.com

Cancel |

f.  Verify you can see and drop down nodes within the new connection.
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